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1 Introduction 

1.1 Objectives 
This protocol describes how to: 

• Determine fibril length of sonicated unlabelled α-synuclein preformed fibrils (PFFs) by 
dynamic light scattering (DLS) and electron microscopy (EM) 

• Confirm cellular uptake of fluorescently-labelled α-synuclein PFFs by immunofluorescence 
(IF) 

• Qualitatively verify the formation of amyloid beta-sheets in α -synuclein PFF by Thioflavin 
(ThT) assay.  

 

1.2 Protocol Overview 
The characteristics of α-synuclein PFFs must be validated prior to experimental use by 
performing quality control analyses of fibril length and cellular uptake (Figure 1). 

Fibril length of sonicated α-synuclein PFFs is first assessed through quantification of particle 
size by DLS; α-synuclein monomers may be analyzed in parallel as a control. This analysis will 
provide the size distribution of fibrils within the sample (i.e. the proportion of fibrils in the sample 
of a specific length). The length of the majority of fibrils in a sample of sonicated α-synuclein 
PFFs should be ≤100 nm in hydro-dynamic diameter. 

Then, sonicated α-synuclein PFFs are visualized by EM using negative staining to quantify fibril 
length and assess fibril uniformity; non-sonicated α-synuclein PFFs may be analyzed in parallel 
as a control. Note that α-synuclein monomers are too small to be visualized by EM. The 
average fibril length of α-synuclein PFFs should be approximately 55 nm after sonication for 30 
seconds, and ≤50 nm after sonication for 60 seconds. 

Cellular uptake is assessed by treating cells with fluorescently-labelled α-synuclein PFFs. The 
intracellular inclusions formed by the α-synuclein PFFs are visualized by IF. 

ThT displays largely enhanced fluorescence emission at 480-510 nm when it binds to β-sheet-
rich structures such as amyloid fibrils, whereas no significant increase in fluorescence is shown 
with monomeric protein or PBS as control. This can therefore be employed to verify the maturity 
of synuclein PFF in vitro.   
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Figure 1. Protocol overview for analyzing α-synuclein PFFs by DLS and EM to determine average fibril length 
and for analyzing cells treated with α-synuclein PFFs by IF to confirm cellular uptake. 

Once validated, α-synuclein PFFs may be used to induce pathology in cell- and animal-based 
experiments. For in vivo experiments, α-synuclein PFFs must be validated by DLS and EM at 
minimum. Note that batches of α-synuclein PFFs that pass the quality control analyses 
described in this protocol are not guaranteed to be pathogenic in vivo. 

 

1.3 List of updates from previous versions of the protocol 
• The end-point Thioflavin-T assay was added (page 16). 
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1.4 Technical and safety considerations 
The following information should be read before starting: 

• While working with α-synuclein PFFs: 

– Wear appropriate personal protective equipment at all times, including disposable gloves, 
a laboratory coat, a face mask, and protective goggles. 

– Preparation of PFFs for DLS and EM must be performed in a sterile Class II biosafety 
(BSLII) cabinet. 

– Avoid inhaling PFFs or getting aerosolized PFFs in eyes. 

• After working with α-synuclein PFFs: 

– Clean area with 1% SDS to destroy fibrils, then rinse area with sterile distilled water. 
– Dispose of all tips, tubes, cuvettes, and media into a large empty bottle or a 50-mL tube 

containing 1% SDS. Store items in 1% SDS for at least 2 hours to disassemble the α-
synuclein PFFs. 

– Dispose of gloves and face mask in an autoclavable biohazard bag to be sterilized. 

• For further information on the use of SDS to break down α-synuclein PFFs, refer to Bousset 
et al. 2016. J. Parkinson Dis. (6) 143–151. 

• Store α-synuclein PFFs at –80°C and thaw at room temperature. Do not store PFFs on ice 
or at 4 °C, as this causes dissociation and reduces activity. 

• Do not vortex α-synuclein PFFs. 
• Instructions for using an electron microscope are complex and specific to the microscope 

model. All users must be trained on the microscope being used. 
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2 Materials 

The material, reagents, and equipment listed in this document can be substituted for those 
supplied by other manufacturers. However, the performance of the assay may not be the same 
and may need to be optimized or redeveloped upon significant modifications to the materials 
and/or methods. 

Refer to the product data sheet from the supplier for further details on storage and preparation 
instructions. 

2.1 Labware 
Item Supplier Catalogue # 
Copper grid, carbon-coated, 
200 mesh 

SPI Supplies 3520C-FA 

Coverslips, 12-mm Fisher 12-545-80 
Culture plate, 12-well Fisher 08-772-29 
Culture plate, 96-well Corning 3880 
Dish, Pyrex brand 3140 (190 
mm x 100 mm) 

Cole-Parmer Scientific 
Experts 

RK-34550-08 

Microscope slides Fisher 12-552-3 
Quartz cuvette, ultra low 
volume 

Malvern Panalytical ZEN2112 

Spray bottle Fisher 01-189-100 
Syringe filter, 0.1-µm 
Whatman Anotop 10 

Sigma Aldrich WHA68091012 

Syringe filter, 0.22-µm, nylon Mandel Scientific WYV-SFNY013022NC 
Tubes, 1.5-mL Fisher MCT-175-LC 
Tubes, 50-mL Fisher Scientific 14-959-49A 
Tweezers, ultra-fine Electron Microscopy 

Sciences (EMS) 
78318-3 

Whatman® qualitative filter 
paper, Grade 1, 15-mm, 500 
circles 

GE Life Sciences 1001-0155 

 

2.2 Reagents 
Item Supplier Catalogue 

# 
Stock 
conc. 

Working 
conc. 

Storage 
temp. 

DMEM Wisent 
Bioproducts 

319-015-CL 1x 1x 4°C 

Ethanol (EtOH) Greenfield 
Global 

26456 100% 70% RT 

Fetal bovine serum 
(FBS) 

Wisent 
Bioproducts 

080-150 100% 10% Stock:  
–80°C 
Working: 
4°C 

Glycine BioShop GLN001.5 NA 0.1M RT 
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Item Supplier Catalogue 
# 

Stock 
conc. 

Working 
conc. 

Storage 
temp. 

HeLa cells ATCC ATCC® 
CCL-2™ 

NA NA Liquid 
nitrogen 

Hoechst ThermoFisher 
Scientific 

H3570 10 mg/mL 5 μg/mL 4°C 

Hydrochloric acid 
(HCl) 

Fisher Scientific 7647-01 NA NA 4°C 

Paraformaldehyde 
(PFA) 

Electron 
Microscopy 
Sciences 
(EMS) 

30525-89-4 16% 4% Stock: RT 
Working: 
4°C 

Penicillin-
streptomycin 

Wisent 
Bioproducts 

450-200-EL 100x 1x Stock:  
–80°C 
Working: 
4°C 

Phosphate buffered 
saline (PBS) 

Wisent 
Bioproducts 

311-012 10x 1x RT 

Sodium dodecyl 
sulfate (SDS) 

Wisent 
Bioproducts 

800-100 20% 1% RT 

Thioflavin T (ThT)  AnaSpec, Inc AS-88306 25mM 12.5 nM -20°C  
Triton X-100 BioShop TRX777.500 NA 1% RT 
Uranyl acetate* Electron 

Microscopy 
Sciences 
(EMS) 

22400-2 NA 2% 4°C 

*Light-sensitive reagent. Stock and working aliquots should be covered in aluminum foil to minimize 
exposure to light. 

 

 

2.3 Equipment and Software 
Item Supplier Catalogue # 

Tecnai 12 BioTwin 120 kV 
transmission electron 
microscope (TEM) or Tecnai 
G2 Spirit Twin 120 kV Cryo-
TEM 

FEI N/A 

EVOS XL Core cell imaging 
system 

ThermoScientific  EVOS XL Core  

Fiji-ImageJ software ImageJ N/A (download at: 
https://imagej.nih.gov/ij/) 

Malvern Zetasizer Software 
for Zetasizer Nano S, 7.13 

Malvern Panalytical N/A 

Matlab R2017b software Mathworks N/A 
Stirrer plate VWR 97042-706 
Zetasizer Nano S Malvern Panalytical Zetasizer Nano S 
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Item Supplier Catalogue # 

EnSpire® 2300 96-well plate 
reader 

Perkin Elmer N/A 
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3 Protocol 

3.1 Dynamic light scattering 
Materials: 

• Sonicated unlabelled α-synuclein PFFs 
• α-synuclein monomers (optional) 
• 1.5-mL tubes 
• 1x PBS 
• 0.1-μm syringe filter 
• Centrifuge 
• Zetasizer Nano S system with Malvern Zetasizer software 
• Ultra low volume quartz cuvette 

Procedure: 

1. Pass 10 mL of PBS and through a 0.1-µm syringe filter. 

• The filtered PBS will be the blank for the particle size analyzer. 

2. Prepare ≥0.6 mg/mL α-synuclein PFFs by diluting in filtered PBS. 
3. Centrifuge α-synuclein PFFs at 13,000 rpm for 5 minutes and then transfer the supernatant 

to a fresh 1.5-mL tube. 

• Take care not to remove any particles from the bottom of the tube when removing the 
supernatant. 

• If analyzing α-synuclein monomers, pass at least 60 μL of diluted samples (≥0.6 mg/mL) 
through a 0.1-µm syringe filter. 

4. Analyze the supernatants using the Zetasizer Nano S system. See Appendix 4.2 for 
instructions to set up and run the measurement SOP using the Malvern Zetasizer software. 
An example of particle size quantification is shown in Figure 2 and the raw correlation data 
is shown in Figure 3. 

• The Zetasizer Nano S system must be turned on 20 minutes before use to allow the 
instrument to thermally equilibrate. 

• The length of the majority of fibrils in a sample of sonicated α-synuclein PFFs should be 
≤100 nm. 

• The raw correlation data curve shows the correlation of scattering intensity during time 
measured (Figure 3). The correlation curve should be smooth and tend to intercept with y 
axis just below a value of 1 (optimal) or between 0.2 to 0.99 (acceptable). If curve decay 
starts anywhere below 0.1 and is bumpy at earlier timepoints on the x axis, it indicates 
that the sample concentration is too low and is not acceptable for the DLS measurement. 
Other factors that yield a bumpy curve, particularly at later timepoints on the x axis, 
include sample sedimentation, polydispersity (Pdi), and aggregation. In these cases, 
sample preparation should be optimized using methods such as centrifugation or filtration 
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to remove sediments, aggregates, and other large species. For more information on 
correlation curves, see Appendix 4.2.1. 

 

•  
Figure 2. Particle size quantification of α-synuclein PFFs sonicated for 60 seconds (2 x 30 seconds). 
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Figure 3. Raw correlation data for particle size quantification of α-synuclein PFFs sonicated for 60 
seconds (2 x 30 seconds). 
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3.2 Electron microscopy 
Materials: 

• Sonicated unlabelled α-synuclein PFFs 
• Non-sonicated unlabelled α-synuclein PFFs (optional) 
• 1.5-mL tubes 
• 200-mesh carbon-coated copper grid 
• Whatman paper 
• Ultra-fine tweezers 
• Glass dish (190 mm x 100 mm) 
• 0.22-μm sterile syringe filter 
• 70% EtOH 
• 2% uranyl acetate 
• 4% PFA 
• Centrifuge 
• EM 
• Software to quantify PFF length (see Appendix 4.1) 

Procedure: 

1. Clean the biosafety cabinet surface, tweezers, and glass dish with 70% EtOH. 
2. To remove impurities from the 4% PFA and 2% uranyl acetate solutions, filter solutions 

separately with a 0.22-µm syringe filter, or centrifuge solutions at maximum speed for 5 
minutes and use the supernatant in steps 5 and 7, respectively. 

3. Prepare 20 µM α-synuclein PFFs in ddH2O. 
4. Add 5 µL of 20 µM α-synuclein PFFs to the grid. Wait for 2 minutes, and then remove 

sample drop from the grid with Whatman paper. 
5. Add 5 µL of 4% PFA to the grid. Wait for 1 minute, and then remove the PFA from the grid 

with Whatman paper. 
6. Add 5 µL of ddH2O to the grid. Wait for 1 minute, and then remove the ddH2O from the grid 

with Whatman paper. Repeat this step 3 more times. 
7. Add 5 µL of 2% uranyl acetate to the grid. Wait for 1 minute, and then remove the uranyl 

acetate from the grid with Whatman paper. 
8. Cover the grid with the glass dish and allow to dry for at least 30 minutes. 
9. Visualize grid on EM to analyze fibril length (see Appendix 4.1 for analysis procedure). 

Examples of EM micrographs and fibril length quantificaiton data are shown in Figure 4. 

• Average fibril length should be approximately 55 nm after sonication for 30 seconds and 
≤50 nm after sonication for 60 seconds. 
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Figure 4. EM microphotographs and fibril length quantification of non-sonicated α-synuclein PFFs and α-
synuclein PFFs sonicated for 30 seconds. 
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3.3 Immunofluorescence 
Materials: 

• Sonicated α-synuclein PFFs fluorescently labelled with Alexa Fluor™ 488 (PFF-488), Alexa 
Fluor™ 568 (PFF-568), or Alexa Fluor™ 633 (PFF-633) 

• 12-well plate 
• Coverslips 
• HeLa cells 
• Media: 

Media Components 
HeLa cell media • DMEM 

• 1x Pen-Strep 
• 10% FBS 

 

• 1x PBS 
• 4% PFA 
• Hoechst stain (10 mg/mL) 
• 37°C/5% CO2 cell culture incubator 
• Microscope slides 
• Fluorescence microscope 

Procedure: 

1. Plate HeLa cells in media at a density of 20,000 cells/1 mL/well on a 12-well plate containing 
coverslips. 

2. The next day, prepare 2 µM α-synuclein PFFs in PBS. Add 10 µL of 2 µM α-synuclein PFFs 
to each well (final concentration will be 20 nM). 

3. After 24 hours, remove media and wash each well with 1 mL PBS. 
4. Add 1 mL 4% PFA to each well and incubate at room temperature for 15 minutes. 
5. Wash each well twice with 1 mL PBS. 
6. Prepare Hoechst stain solution by diluting 10 mg/mL stock 1:2000 in PBS (final 

concentration is 5 μg/mL). Add 1 mL to each well and incubate at room temperature for 5 
minutes. 

7. Wash each well three times with 1 mL PBS. 
8. Mount coverslips onto slides. 
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9. Visualize slides on fluorescence microscope using a 10X or 20X objective lens. An example 
image of fluorescently-labelled α-synuclein PFFs in HeLa cells is shown in Figure 5. 

• Slides can be stored at 4°C protected from light until ready to image. 

 

 

Figure 5. IF of HeLa cells treated for 24 hours with 20 nM α-synuclein PFF-633 Blue: Hoechst; red: PFF-
633. 
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3.4 End-point Thioflavin-T assay 
Materials: 

• 0.1M glycine-HCl buffer (pH 8.5) supplemented with 1% Triton X-100. 
• 25 mM ThT (AnaSpec, Inc. cat# AS-88306) stock solution 
• Phosphate buffer saline (PBS, Wisent Inc.). 
• 5 mg/ml of PFF or α-synuclein monomer.  
• 96-well plate (half area, black with clear bottom. Corning, cat# 3880). 
• 96-well plate reader (Perkin Elmer EnSpire® 2300). 
 

Procedure: 

1. Prepare 25 mM ThT stock solution by dissolving 7.97 mg of ThT in 1 ml of glycine-HCl buffer 
(shown above), aliquot to 50 ul per tube and store at -20oC freezer. 

• IMPORTANT: ThT working solution (25 uM) is prepared by freshly diluting from ThT 
stock solution (25 mM) with glycine-HCl buffer just before use. Wrap with aluminum foil to 
avoid direct light. 

2. Before sampling, mix the PFF sample to test by repeatedly pipetting up and down.  
3. Transfer 3 µl of PFF to a 1.5-ml microtube holding 297 µl of glycine-HCl buffer (pH8.5), mix 

the suspension well by repeatedly pipetting.  
4. Meanwhile, use 3 µl of phosphate buffer saline (PBS) or α-synuclein monomer to substitute 

the PFF for preparing blank controls. 
5. Add 300 µl of 25 µM ThT solution to each of the microtubes and mix well, wrap each tube 

with aluminum foil and leave at room temperature for 20 min. 
6. Dispense 100 µl of reaction mixture into each well of a 96-well black plate, three to five 

replicates are used for each sample and blank control. 
7. Read the plate (without coverlid) in a microplate reader with wavelength settings: excitation 

at 450 nm and emission at 490 nm. 
 

• For further information on the ThT assay, please, refer to Patterson et al. 2019. J. Vis. Exp. 
(148), e59758, doi:10.3791/59758 
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4 Appendix 

4.1 Quantifying fibril length in EM micrographs 
Materials: 

• EM micrograph image files 
• Fiji-ImageJ software 
• Microsoft Excel software 
• Matlab R2017b software 

1. Open the Fiji-ImageJ software and open image file. 
2. Select the Straight Line tool and draw a line along the scale bar of the image. From the 

Analyze menu, select Set Scale…. Enter the known distance and unit of length of the scale 
bar (e.g. 100 nm) and check the checkbox for Global. 

• The magnification used to acquire the image and the type of microscope defines the 
scale bar. Therefore, the known distance and unit of length depends on the image scale 
bar. 

• Setting the scale to Global ensures that measurements for all images are based on the 
same scale. 
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3. Select the Straight Line tool to measure the length of all of the fibrils in the image. Repeat 
process for all images to be analyzed. Open the ROI manager by entering CTRL+T. Check 
the checkboxes for Show all and Labels. 

• Do not measure fibrils that are touching the borders of the image. 
• Measure 100 to 200 fibrils per sample. 

 

4. In the Results window, under the Edit menu, select Select All. Under the Edit menu, select 
Copy. Open a new Excel file and paste the data into the spreadsheet. 

 

5. In Excel, select Filter from the Sort & Filter pull-down menu on the Editing panel of the 
Home ribbon. Filter the data in the Length column to determine the minimum and maximum 
fibril length measured. Calculate the average and the median of the data in the Length 
column. 

 

6. Open the Matlab R2017b software. Run the following macro to import the data from the 
Excel file and generate a histogram of the fibril lengths. 
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• Ensure that the file name and extension (.xls or .xlsx) in the macro (purple text) matches 
the file name and extension of the Excel file containing the data to be imported. 

 

7. In the histogram window, select the Spot Tool (indicated by the red box in the image) to 
modify the x-axis range to 0 to 120 to exclude long fibrils and obtain a better distribution of 
lengths. 

 

8. Save the histogram as an image file (.tiff or .jpeg). 
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4.2 Instructions for using Malvern Zetasizer software on the Zetasizer 
Nano S system 

1. Turn on the Zetasizer Nano S system and open the Malvern Zetasizer software . 

• The instrument must be turned on 20 minutes before use to allow the instrument to 
thermally equilibrate. 

• The instrument will beep when turned on, and then beep again once it has completed the 
initialization routine. 

• The light on the status indicator around the cell access button will turn from red to green 
once the system is ready for use. 

 

2. In the Zetasizer window, under the File menu, create a new measurement file by selecting 
Measurement File from the options under New. 

• If opening an existing measurement file, select Measurement File from the options under 
Open. 
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3. In the Zetasizer window, under the Measure menu, select Manual to perform a manual 
measurement. A Manual measurement window will open. 

• If running an existing SOP, select Start SOP from the Measure menu. 

 

4. In the Manual measurement window, select Settings . A Settings window will open. 
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5. In the Settings window, input the following parameters only (do not change any other 
parameters from the default settings). 

• In the Sample parameters, type “Blank” in the Sample name field. 
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• In the Material parameters, select Protein. 
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• In the Solvent parameters, select Water or ICN PBS Tablets. 
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• In the Temperature parameters, set the Temperature to 22°C and set Equilibration 
time (seconds) to 60. 
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• In the Cell parameters, select ZEN2112. 
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• In the Measurement parameters, set the Number of measurements to 3 and set the 
Delay between measurements to 0. 
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• In the Measurement parameters, under Advanced, keep default parameters. 
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• In the Data Processing parameters, select General purpose (normal resolution). 

 

6. Select OK to save the settings. 

• To create a new SOP with these settings, select Save under the File menu and then 
select Save as SOP. 
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7. Add 16 µL of filtered PBS into a clean cuvette and close with cap. 

• Always hold the cuvette from the top. 

 

• Avoid introducing bubbles into the solution when adding it to the cuvette. 

8. Place the cuvette containing the PBS into the cell area of the instrument with the label facing 
you and close the instrument lid. 

 

9. In the Manual measurement window, select Start . When the measurement is complete, 
remove the cuvette containing the PBS. 

10. In the Manual Measurement window, select Settings . In the Sample parameters, 
change the text in the Sample name field to the sample name. Repeat steps 7 to 10 for 
each sample. 

• Wash cuvette three times with 500 μL of filtered PBS between samples. 

11. Wash cuvette three times with warm ddH2O water after all samples have been measured. 
12. Fill cuvette with 1 mL 1% SDS, cap, and store for 24 hours at room temperature to 

decontaminate. 
13. Turn off the instrument and close the software. 
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4.2.1 Raw correlation data curve 
The raw correlation data curve provides information about the integrity of the sample. The 
features of the correlation curve are indicated in the image. 

 

The correlation curve should be smooth. A bumpy curve indicates problems with the sample 
preparation. 

• If there is sedimentation in the sample, the curve will appear bumpy at later timepoints, as 
shown in the image. 
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• If the sample concentration is too low, the curve will appear bumpy at earlier timepoints, as 
shown in the image.  

 

• Similarly, the curve for the blank is bumpy at earlier timepoints, as shown in the image. 
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